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1 .  O v e r v i e w  o f  A s s a y s
Both Invivoscribe’s IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 and IdentiClone TCRG Gene 
Clonality Assay were designed to identify T-cell clonality in suspect lymphoproliferations and are to be used in conjunction 
with other laboratory tests and results interpreted in the context of all available information.  Despite this similarity, there 
are some noteworthy differences. 

The IdentiClone TCRG Gene Clonality Assay includes two master mixes: TCRG Tube A and TCRG Tube B.  TCRG Tube A 
contains primers that target the Vγ1-8 + Vγ10 genes and Jγ1.1, Jγ1.3, Jγ2.1, and Jγ2.3 genes (also known as JγP1, Jγ1, JγP2, and 
Jγ2, respectively), generating 4 polyclonal distribution size ranges.  TCRG Tube B contains primers that target the Vγ9 + Vγ11 
genes and Jγ1.1, Jγ1.3, Jγ2.1, and Jγ2.3 genes, generating 4 polyclonal distribution size ranges (see figure). 

Conversely, the IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 includes a single master mix,  
TCRG – 6FAM, which targets genes described in lymphoid malignancies, including the Vγ2, 3, 4, 5, 8, 9, 10, & 11 and Jγ1/
Jγ2,JγP, and JγP1/JγP2 regions. The resulting polyclonal background lies within a single valid size range, generating a more 
robust and easily interpreted signal in comparison to other TCRG clonality assays which have multiple valid size ranges.  
Moreover, this design is better suited to detect TCRG gene rearrangements in FFPE samples, due to its smaller valid size 
range of 159 bp to 207 bp (see figure).

 
Some of the benefits of the IdentiClone T-Cell Receptor Gamma Gene Rearrangement 2.0 Assay include:

•  Allows a higher sample throughput with the single master mix assay  
•  Offers easy setup and simpler interpretation than the two-tube approach 
•  Generates smaller amplicon sizes, meaning better success when testing FFPE samples 
•  Reduces the DNA required for testing by half by reducing PCR reactions from two to one 

    
Figure 1: GeneScan analysis indicating rearrangement valid size ranges generated from the same polyclonal 
sample with the assays listed below.

(A)  IdentiClone TCRG Gene Clonality Assay, TCRG Tube A master mix;  
(B)  IdentiClone TCRG Gene Clonality Assay, TCRG Tube B master mix;  
(C)  IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0, TCRG-6FAM master mix

Figure adapted from:  Marine, A., et al., (2019) HemaSphere 3(3):e255.
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2 .  A s s a y  P e r f o r m a n c e  C h a r a c t e r i s t i c s  
 
These two assays were designed differently, thus the results generated with each assay are interpreted differently.  
The primary improvements of the IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 over the 
IdentiClone TCRG Gene Clonality Assay are the addition of JγP target and consolidation of multiple polyclonal 
distributions into a single distribution. When PCR products are grouped into a single distribution, it generates  
an increased signal, improving sensitivity and reducing the likelihood of false positive from minor peaks in dispersed 
repertoires.  For example, minor peaks in the Vγ11 valid size range can be mistakenly reported as significant due  
to lack of other polyclonal peaks within that distribution.

Because the IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 targets more regions compared 
to the IdentiClone TCRG Gene Clonality Assay, it detects more types of rearrangements.  Furthermore, the different 
primer designs used by these assays could exhibit variability when comparing results generated by the two 
assays.  If a primer binding site utilized by the IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 
is mutated, the intended primer may not bind efficiently and result in low amplification of the target in question; 
IdentiClone TCRG Gene Clonality Assay primers may bind at a different location and amplify the same target.  The 
opposite may be true as well.

Overall, we do expect a high degree of concordance between the two assays, but it is not expected to be 100%, as 
these are different assays with unique primer designs.  The following references compare the and describe the 
characteristics and workflow parameters of the one-tube and/or two-tube assays:

Assay Design Affects the Interpretation of T-Cell Receptor Gamma Gene Rearrangements1  
https://www.ncbi.nlm.nih.gov/pmc/articles/PMC2963914/

A Single-Tube, EuroClonality-Inspired, TRG Clonality Multiplex PCR Aids Management of Patients with 
Enteropathic Diseases, including from Formaldehyde-Fixed, Paraffin-Embedded Tissues2  
https://jmd.amjpathol.org/article/S1525-1578(18)30173-9/pdf

A New and Simple TRG Multiplex PCR Assay for Assessment of T-cell Clonality3  
https://journals.lww.com/hemasphere/Fulltext/2019/06000/A_New_and_Simple_TRG_Multiplex_PCR_Assay_for.8.aspx
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3 .  A d d i t i o n a l  P o s i t i v e  C o n t r o l s 
While both assay kits include positive and negative controls, Invivoscribe offers additional controls that are compatible with 
these kits. Please see Table 1 for details.

Table 1.  Positive Controls Compatible with either or both TCRG assays
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Part Number Description
Product Size(s) 

TCRG Gene Clonality Assay T-Cell Receptor Gamma Gene 
Rearrangement Assay 2.0

40880190     100% IVS-0004 Clonal Control DNA TCRG Tube A: 211 bp 
TCRG Tube B: n/a TCRG – 6FAM: 179 bp and 188 bp

40880430 100% IVS-0008 Clonal Control DNA TCRG Tube A: 218 bp and 229 bp 
TCRG Tube B: n/a TCRG – 6FAM: 195 bp and 207 bp

40880490  100% IVS-0009 Clonal Control DNA TCRG Tube A: 212 bp 
TCRG Tube B: 115 bp TCRG – 6FAM: 188 bp and 191 bp

40881210 100% IVS-0021 Clonal Control DNA TCRG Tube A: 211 bp 
TCRG Tube B: 143 bp and 167 bp TCRG – 6FAM: 183 bp and 188 bp

4 .  S a m p l e  I n t e g r i t y
Invivoscribe capillary fluorescence assays generate robust results using genomic DNA (gDNA) extracted from a wide array 
of specimen types.  If the integrity of the sample is in question, the Specimen Control Size Ladder master mix can be used 
to verify the quality and quantity of the extracted gDNA is suitable to generate results with Invivoscribe assays.  Specimen 
Control Size Ladder master mixes are included with most Invivoscribe kits, including the IdentiClone T-Cell Receptor Gamma 
Gene Rearrangement Assay 2.0.  Examples of the expected results for Gel and ABI Fluorescence detection with this master mix 
are shown in Figure 2, respectively:

 
 
 
 
Figure 2:  Expected results amplifying gDNA with: (Right) the Specimen Control Size Ladder - Unlabeled for 
Gel Detection (Catalog #20960020).  Expected product size are indicated in red; a 100 bp ladder is also shown 
for size reference. (Below) the Specimen Control Size Ladder – 6FAM for ABI Fluorescence Detection (Catalog 
#20960021).  Expected product sizes are indicated in red and actual product sizes are indicated in black.



5 .  S a m p l e  I n t e r p r e t a t i o n

Many publications have indicated T-cell receptor gamma gene rearrangement analysis is useful as an ancillary test  
in the diagnosis of T-cell neoplasms.1-6  However, the design of the assay can have a large impact on assay interpretation, 
correlating increasing assay complexity with more complicated and difficult interpretation.1,3  

The IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 was designed with this consideration in mind, 
simplifying interpretation by using an individual, yet comprehensive, master mix labeled with one fluorochrome that 
generates a single, robust valid size range.  This is a major improvement in comparison to the IdentiClone TCRG Gene 
Clonality Assay, which uses two master mixes labeled with two fluorochromes that generate a total of eight valid size 
ranges for interpretation.  A comparison of assay interpretation guidelines is provided in Table 2.

The higher complexity of the IdentiClone TCRG Gene Clonality Assay can lead to false positive results due to low-amplitude 
polyclonal distributions with pseudoclonal peaks.1  Because of the limited repertoire generated by TRG rearrangements, 
amplification of a sample with a high tumor load and limited number of T-cells can generate products that appear  
to be (oligo) clonal or pseudoclonal.6  

 
Table 2. Comparison of Invivoscribe TCRG Assay Interpretation Guidelines
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Interpretation by Assay

Final Call (Sample Report)
IdentiClone TCRG Gene Clonality Assay 

 Valid Size Range

TCRG Tube A:  145 bp – 255 bp 
TCRG Tube B:  80 bp – 220 bp* 

IdentiClone T-Cell Receptor Gamma Gene 
Rearrangement Assay 2.0

Valid Size Range

TCRG – 6FAM:  159 bp – 207 bp

1 or 2 significant peaks within the valid size range(s).

Significant Peak:  3X amplitude of 3rd highest peak 
within the same polyclonal distribution 

1 or 2 significant peaks within the valid size range

Significant Peak:  4X amplitude of lower neighboring peak

Detection of TCRG Gene 
Rearrangements, consistent 

with the presence of a clonal cell 
population.

N/A
3 or more significant peaks within the valid size range

Significant Peak:  4X amplitude of lower neighboring peak

Detection of TCRG Gene 
Rearrangements, consistent with 

the detection of biclonality or 
oligoclonality.

Absence of significant peaks within the  
valid size range(s) Absence of significant peaks within the valid size range Negative for detection of TCRG 

Gene Rearrangements.

*Interpret peaks within context of all sample information.



6 .  U s i n g  t h e  I d e n t i C l o n e  T - C e l l  R e c e p t o r  G a m m a 
G e n e  R e a r r a n g e m e n t  A s s a y  2 . 0  A l g o r i t h m  W o r k s h e e t

The IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 includes an Algorithm Worksheet (provided  
on CD, Part Number 261354).  This Algorithm Worksheet facilitates data analysis by providing calculations for the relative 
peak height ratio (RPR) and a statistical derivative value, D(x), for each peak.   
 
The RPR is calculated by dividing the height of each peak to the smaller of its neighboring peaks and it must exceed a value 
of 4.0 to be considered positive of clonality.  
 
The D(x) value is based on a variation of the Kolmogorov-Smirnov test, which compares two empirical distributions and 
determines whether they are statistically different and its value must be greater than 0.0419.  
 
The algorithm requires a reasonably consistent signal background and the data must be entered correctly, as gaps in the 
background can cause the algorithm to call a sample incorrectly.  Furthermore, the results generated by the algorithm must 
be verified by reviewing the corresponding electropherogram(s) to confirm the validity of the interpretation.  This important 
step may identify the need to lower the Minimum Peak Height threshold in GeneMapper to 1) ensure that peaks are 
distinguishable from the background noise and 2) allows the selection of peaks within the Gaussian distribution prior to the 
algorithm worksheet analysis.  Lastly, when facing discordant duplicate results, please consider the context of all available 
clinical, histological, and immunophenotypic data.  Please see Table 3 for the potential sample interpretation results.

 
Table 3. Potential Sample interpretation Results

Algorithm Result Electropherogram Result Final Call (Sample Report)

1 or 2 significant peaks are indicated
1 or 2 peaks within the valid size range with:

RPR ≥ 4.0 and/or 
≥ 20% of the RFU of the highest adjacent peak in that sample

Detection of TCRG Gene 
Rearrangements, consistent with the 
presence of a clonal cell population.

3 or more significant peaks are indicated
3 or more peaks within the valid size range with:

RPR ≥ 4.0 and/or 
≥ 20% of the RFU of the highest adjacent peak in that sample

Detection of TCRG Gene 
Rearrangements, consistent with the 

detection of biclonality or oligoclonality.

No significant peaks indicated Absence of significant peaks within the valid size range Negative for detection of TCRG Gene 
Rearrangements.

Note: RPR is calculated by dividing the height (in RFU) of the significant peak by the height of the smaller of its neighboring peaks. 
 
 
In the event that the IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 Algorithm Worksheet does not 
detect significant peak(s) within the Gaussian distribution, the minimum threshold for peak detection may be set too high.  
However, before taking any action, verify the run validity by ensuring the controls generated the expected results. If the run 
is valid, the following steps can be performed to decrease the Minimum Peak Height threshold: 
 
1. Select GeneMapper Manager from the Tools Menu, then navigate to the Analysis Methods tab and open the       
    Microsatellite Default Analysis Method Editor.  
2. Navigate to the Peak Detector tab, select User Specified (rfu) toggle, and input the desired peak height for the Blue  
    dye (6FAM).  
 
Lowering the threshold should allow the algorithm worksheet to identify significant peak(s), however this may not always  
be the case.  
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7. P r o t o c o l  T i p s :   I d e n t i C l o n e  T - C e l l  R e c e p t o r  
G a m m a  G e n e  R e a r r a n g e m e n t  A s s a y  2 . 0

Importing Plate Layout into GeneMapper

1. Open a new project and select Microsatellite for the project type.   
2. Add raw data files derived from CE analysis to the project using the Add samples to Project icon in the toolbar. 
3. Once the samples are added, verify that Analysis Method selected is Microsatellite Default and that the appropriate Size    
    Standard is selected.

 • If necessary, select samples and press the Analyze green play button in the toolbar. 
 • There will be a green, yellow, or red symbol in the SQ column for each analyzed sample.

4. If the symbol is red, the software will not calculate the peak sizes or display the sample data.  In this case, view the size standard  
    chart by selecting samples and clicking the Size Match Editor icon in the toolbar to verify the peak sizes were correctly identified.  

 • If the SQ peaks were called correctly, click Override SQ, and then Apply. 
 • If some peaks were called incorrectly, re-assign the peaks by right clicking and selecting the correct size values.

  o The GS 400 HD ROX size standard provides 21 labeled fragments of: 50, 60, 90, 100, 120, 150, 160, 180, 190, 200, 220,  
       240, 260, 280, 290, 300, 320, 340, 360, 380, and 400 nucleotides (nt). 
  o The GS 600 LIZ Size Standard provides 36 single-stranded labeled fragments of: 20, 40, 60, 80, 100, 114, 120, 140,  
      160, 180, 200, 214, 220, 240, 250, 260, 280, 300, 314, 320, 340, 360, 380, 400, 414, 420, 440, 460, 480, 500, 514, 520,  
      540, 560, 580 and 600 nt.

5. Select any samples that have a green play button in the Status column of the GeneMapper table and press the Analyze green  
    play button in the toolbar.

 • Please note, it may be necessary to lower the Minimum Peak Height threshold in order to detect all peaks  
    in a Gaussian distribution:

  o Select GeneMapper Manager from the Tools menu, navigate to the Analysis Methods tab, and open the   
     Microsatellite Default Analysis Method Editor.  
  o Navigate to the Peak Detector tab, select User Specified (rfu) toggle, and input the desired peak height  
     for 6FAM dye.

 • If changes are made, click the Analyze green play button in the toolbar.

6. In the GeneMapper table, highlight the samples of interest and select Display Plots in the GeneMapper toolbar. 
7. Once the Display Plot is open, verify that Microsatellite Default is selected in Plot Settings and the appropriate fluorophore  
    is selected (6FAM).  

 • Select/Deselect the associated colored boxes in the toolbar, OR navigate to the View menu in the Display Plot, select Dyes,  
    and select the appropriate dyes.

  o As a reminder, 6FAM is Blue, HEX is Green, NED is Yellow or Black and ROX is Red in GeneMapper v4.0.

8. In order to view the peak size and height, select the Sizing Table icon in the toolbar.
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Recommended Injection Parameters and Peak Detector Settings for the IdentiClone T-Cell Receptor Gamma 
Gene Rearrangement Assay 2.0

Injection Parameters*

 
 
 
 
 
Analyzing Samples in GeneMapper 
 
• Examine all assay controls prior to interpretation of sample results.  If the controls do not yield the correct results, the assay  
   is not valid and the samples should not be interpreted. 
• When analyzing the samples in GeneMapper, only analyze peaks within the valid size range of the master mix.   
• To determine whether a peak is clonal or polyclonal, compare the height of the peak to the height of the polyclonal        
   background within the same sample.  

 o A validation study is recommended to determine an appropriate peak height ratio.  

• Do not use RFU values to determine whether a peak is clonal, as RFU values can be affected by a variety of factors, such  
   as the capillary array and laser life.  

 
Troubleshooting Size Quality (SQ) Error(s)

A SQ Error indicates that GeneMapper did not identify the size standard peaks correctly, causing the generated products  
to be identified at an incorrect size.  Most SQ errors are caused by saturated signal(s), resulting in spectral pullup and  
mis-identification of peak sizes.  If this type of error is observed in undiluted positive controls and the size standard peaks are 
identified correctly or corrected, the SQ Error is of no significance since control validity relies on the presence or absence  
of a peak at the expected size.  However, if signal saturation is observed in the negative control, sensitivity controls, or unknown 
samples, the run must be repeated on the ABI instrument to prevent result misinterpretation.  Before repeating the ABI run 
with samples exhibiting saturated signal(s), adjust the injection conditions and/or dilute amplified products.  Please note that 
diluting unknown sample amplicons could dilute a weak clonal product below the assay level of detection.  The steps below  
will correct SQ Errors:

1. Verify the size standard peaks are correctly identified in the GeneMapper software prior to reviewing the data by selecting    
   the samples then clicking the Size Match Editor icon in the tool bar.   
2. If the peaks labeled with SQ Errors were called correctly, click Override SQ, then click Apply. 
3. If the size standard peaks are identified incorrectly, (in the Size Match Editor) manually reassign the ROX size standard      
   peaks to match the expected sizes:  Right click on the incorrect size value and select the correct size value, then click the     
   Override SQ button.  
4. Repeat step(s) 2 or 3, above, for all samples indicating an SQ Error based on the peak size verification result (step 1). 
5. Click the Analyze green play button to reanalyze the data.

 • The data will update to display the revised product sizes.

If SQ Errors continue to occur, recalibrate the ABI instrument per the manufacturer instructions.  Further optimization to reduce 
the number of SQ Errors includes adjusting the volume of size standard added to each well of the ABI plate.

Parameter Value

Injection Time 7 sec.

Injection Voltage 1.0 kVolts

Capillary Length 50 cm

Polymer POP7

Dye Set G5

Oven Temp 60°C

Run Time 1630 sec.

Run Voltage 19.5 kVolts

PreRun Time 180 sec.

PreRun Voltage 15 kVolts

Data Delay 1 sec.

Parameter Value

Peak Detector Algorithm Basic

Minimum Peak Height User Specified (RFU)

Blue 50 

Orange 50

Valid Size Range 159 bp - 207 bp

 
*Please refer to the user manual for further instructions. 
 
 

Peak Detector Settings*
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Troubleshooting Miscalled/Unidentified Peaks

Another potential issue that may be encountered includes unidentified peaks which are miscalled as belonging to an 
adjacent peak. This phenomena occurs when the electropherogram indicates two adjacent peaks and the peak table only 
indicates one peak. Subsequently, when this data is pasted into the Algorithm Worksheet, the calculation does not identify 
a potentially significant peak because there is no adjacent peak to which it can be compared.  This can easily be remedied 
by changing the Peak Detection settings in GeneMapper, as the software uses the settings Polynomial Degree and Peak 
Window Size to determine the start and end of each peak. The default value for Polynomial Degree is 3 and Peak Window 
Size is 15. Please see Thermo Fisher language regarding these settings below:7

 • Polynomial Degree and Peak Window Size settings affect the peak detection sensitivity.  Adjust these parameters  
    to detect a single base pair difference while minimizing the detection of shoulder effects and/or noise (see Table 3  
    and Figure 3).

Table 3.  Change peak detection sensitivity using Polynomial Degree and Peak Window Size 

 
 
 
 • The peak window size functions with the polynomial degree to set the sensitivity of peak detection. The peak detector  
    calculates the first derivative of a polynomial curve fitted to the data within a window that is centered on each data  
    point in the analysis range.  
 • Using curves with larger polynomial degree values allows the curve to more closely approximate the signal and,   
    therefore, the peak detector captures more of the peak structure in the electropherogram. 
 • The peak window size sets the width (in data points) of the window to which the polynomial curve is fitted to data:

  o Higher peak window size values smooth out the polynomial curve, which limits the structure being detected. 
  o Smaller window size values capture more of the peak structure.

 
To adjust these settings, follow the steps below:

1. Open GeneMapper and from the top menu, select Tools, then GeneMapper Manager. 
2. Navigate to the Analysis Methods tab to view available analysis methods. 

 • An existing Analysis Method can be edited, or (the preferred option) an existing Analysis Method can be edited then  
     saved with a new name.

3. Select Save as… to create a copy of the selected analysis method with a new name.  
4. Select the Analysis Method created in the previous step and click Open.  
5. Navigate to the Peak Detector tab, and set Peak Detection Algorithm to Advanced. 

 • The Peak Window Size and Polynomial Degree settings can now be altered.  

6. Test a few different conditions with a sample set to identify the optimal settings for this instrument.

 • Use the guidelines in Table 3 to determine how to adjust these settings based on the observed issue and anticipated  
    resolution.

Function Polynomial Degree Value Peak Window SizeValue

Increase Sensitivity Higher Lower

Decrease Sensitivity Lower Higher
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Figure 3.  Sample data generated with GeneMapper using the default Peak Detection Algorithm settings  
vs. optimized Peak Detection Algorithm settings.

 
Default Peak Detection Algorithm settings:  Polynomial Degree = 3;  Peak Window Size = 15.  Notice the peak 
indicated by the red arrow is not identified in the peak table, rendering the 173 bp peak as not significant (since 
it is compared to the higher peak on the left). 
 
 
 
 
 
 
 
 
 
 

 
 
 
 
Optimized Peak Detection Algorithm settings: Polynomial Degree = 3;  Peak Window Size = 11.  Notice the peak 
indicated by the red arrow is now identified in the peak table, rendering the 173 bp peak as significant (since it 
is now compared to the lower peak on the right).
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Catalog Number Description Quantity

92070101 IdentiClone T-Cell Receptor Gamma Gene Rearrangement Assay 2.0 33 reactions

92070111 IdentiClone T-cell Receptor Gamma Gene Rearrangement Assay 2.0  MegaKit 330 reactions

These are in vitro diagnostic products and available in regions that accept CE-IVD products.
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